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Introduction 
 
StateCU was developed to allow the user to determine monthly crop consumptive use by the Modified or 
Original Blaney-Criddle methods and the Pochop Method for bluegrass, daily crop consumptive use by 
the ASCE Standardized Penman-Monteith method, and calculate monthly water budgets by structure.  
StateCU was recently enhanced with the creation of the Wizard, which allows a user to develop a 
StateCU scenario in four easy steps. 
 
This Quick Start Manual is a very shortened and step-by-step description of what the model can perform.  
Should you desire to learn how to develop further complex analysis, the StateCU Documentation manual 
is far more extensive than this manual and contains explicit information on developing a scenario dataset. 
 
The two scenarios that will be covered here are:  

• Climate Station Scenario (Crop Irrigation Water Requirement by CU Location)  
• Structure Scenario (Water Supply Limited Crop Consumptive Use by Structure).  

 
 
Climate Station Scenario 
 
From the StateCU main screen, click on “File”, then in the drop down menu, click “Create new StateCU 
scenario with HydroBase Wizard”. 
 

 
 
A welcome screen will open up; it is recommended that you read the pop-up windows to understand the 
default settings within this program.  The default settings are set conservatively.  Should a consultant 
desire to change these settings, supporting documentation should be provided to prove his/her position. 
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The following screen will open up indicating if the user is connected to HydroBase.  Step 1 requires the 
user to provide a name for the scenario. 
 

 
 
In Step 2, the user can designate which crops will be used in the scenario.  Fill in the percentages of your 
crops, they must total 100%.  If the user would like to apply an elevation adjustment to the TR-21 crops, 
check the box in the lower left corner. 
 

 
 
 
Click on the “View info about selected crop” button for more information about the selected crop.  Please 
note that calibrated crop coefficients have been developed for various regions of the state.  The TR-21 
crop coefficients tend to be more conservative.  You cannot make any changes to the crop coefficients at 
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this point, however changes to the crop characteristics and coefficients can be made through the GUI.  
The following is an example of the information available for TR-21 Alfalfa.  
 

 
 
Click on Continue and the following window will open.  Step 3 allows the user to designate a climate 
station to be used in the scenario. 
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The user can search by climate station name or ID, or leave the box blank and select a Division or 
District; clicking the green arrow will refresh the list.  If you scroll to the right, you can see the Start Year, 
End Year and data count and make a determination of which station is the best for your analysis. 
 

 
 
After pressing Continue, the following window will open up.  Recommended Start and End Years based 
on available climate data are set, however if you want your period of record to go back even further, 
change the Begin Year to the value you want, then at a later time you can back fill that data.  Type 
identifying information in the three line scenario description and click on the “Create New Scenario” 
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button.  At this point the Wizard will create a set of StateCU input files reflecting the scenario selections 
the user made in the previous steps. 
 

 
 
After creating the new scenario, a window for StateCU Wizard Default Settings will open up.  Read the 
default settings then, press OK.  The StateCU main page will come up, and the new scenario will already 
be loaded into StateCU.   
 
The input files created by the Wizard are saved to the C:\CDSS\Data\StateCUWizard folder.  The 
following image reflects the input files that the Wizard has created. 
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Edit Climate Station Scenario through the GUI 
 
As the scenario is already loaded into StateCU, the user can review the input files by clicking on the 
“Input File List” under the “Edit” menu.  Here you can redirect the file paths should you wish. 
 

 
 
Analysis options, including CU method and effective precipitation methods, as well as scenario 
descriptions, can be viewed by clicking on the “Model Control Options” under the “Edit” menu. 
 
To make changes to the selected climate station or create a new CU location, click on “Edit”, and then 
click on “Climate Station Information”.  It is on this page that you can make create a climate station for 
your site (Add a Field Location) and you can make adjustments to your Crop Types percentages 
(View/Edit Crop Types). 
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Click on “Add a Field Location”.  You will need to enter a 4 digit number in the Field ID and a 
Field Name.  You can make the adjustments to the Latitude and Elevation, as well as adjustments to the 
Precipitation factor.  The Colorado Decision Support System (CDSS) and Division of Water Resources 
(DWR) web sites provide the State Climatologist long-term annual precipitation values for all locations in 
the state.  The weather station long-term average should be compared against the State Climatologist 
value for the field site so that a precipitation correction factor can be applied to the weather station data 
for use at the field site.   A temperature adjustment of 3.6 degrees cooler per 1000 feet of elevation gain is 
typically accepted if no other data exists.   
 
Once you’ve made your adjustments, click on “File”, then “Save”.  Your new location will show up under 
the existing climate station.  If you need to make changes to the crop types, click on “View/Edit Crop 
Types”.  You can highlight a box and change values, and right click on the box for copy/paste options.  
Remember to save these changes under the “File” menu. 
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Back to the main page, click on Edit, and then click on “Crop Characteristics/Coefficients”.  On this page 
you can make adjustments to the crop characteristics and coefficients (View/Edit Crop Coefficients”). 
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Once all your parameters are adjusted, select “Run”, then “Run Simulation”.  Click on “Results” for 
output options, although the “Time Series Data Report Generator” allows the user to create custom output 
files.   
 
Once in the “Time Series Data Report Generator” is selected, the following window will appear.  On this 
table you will click the “Add Row from Data Source” button.  Click on the drop down for “ID (Name)” 
and select your station.  Then click on the “Data Type” drop down to show the “Irrigation Water 
Requirement” as well as other output options. 
 

 
 
Click on the “Time Series Summary File” for a text file containing your results.  It will show the Max, 
Min, and Mean at the bottom of the page. Graphing and export to Excel is also available.   
 
Congratulations!  You have completed a Climate Station Scenario. 
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Structure Scenario 
 
From the StateCU main screen, click on “File”, then in the drop down menu, click “Create new StateCU 
scenario with HydroBase Wizard”.  Click on the Structure Scenario, you then have the option of using the 
crop acreage and diversion data from HydroBase. Step 1 requires the user to provide a name for the 
scenario. 
 

 
 
In this example we are using the Riverside Canal in Water District 1.  Type the name in, click on District, 
and press the green arrow to show the diversion structures with the name Riverside in them.  Highlight 
the structure to be analyzed.  You can view the structure info or view the diversion total.  If analyzing a 
single source/type of diversions, you can click on “Select Individual DivClass” which will open Step 2A 
seen below.  In most cases you will probably take the total diversion into the structure, then manipulate 
the data in the GUI. 
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Press “Continue” and the crop type and acreage from the most recent irrigated acreage assessment in 
HydroBase for the structure will be shown.  You can make changes in this table by clicking on the value 
and typing your new value in. 
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If the user would like to apply an elevation adjustment to the TR-21 crops, check the box in the lower left 
corner. Click on “Continue” to move to the next step. 
 
In Step 4, you will choose your climate station.  Find the one closest to your site that has a good period of 
record for precipitation and temperature data.  You can scroll over to the right to see the period of record 
for the climate data. 
 

 
 
Press “Continue” to move onto the Final Step as shown in the next window.  
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On this table you have the option to leave any missing data blank or to fill in with averages or some other 
value.  Note that data will be filled only during the StateCU simulation process, the filled data is not 
reflected in your input files.  Recommended Start and End Years based on available climate data are set, 
however if you want your period of record to go back even further, change the Begin Year to the value 
you want, then at a later time you can back fill that data.   
 
If you have a lot of climate data to fill, it is recommended that you don’t use the Fill clim w/ hist ave.  A 
regression fill should be done using a climate station that has a complete period of record.  This can be 
accomplished in our TSTool program.

 

  If there is just a small handful of missing data, then for time and 
convenience, use the average climate fill. 

Type identifying information in the three line scenario description and click on the “Create New 
Scenario” button.  The following default window will open.  It is recommended that you read the pop-up 
windows to understand the default settings within this program.  The default settings are set 
conservatively.  Should a consultant desire to change these settings, supporting documentation should be 
provided to prove his/her position.  These values can be adjusted through the GUI. 
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At this point the Wizard will create a set of StateCU input files reflecting the scenario selections the user 
made in the previous steps.   
 
Edit Structure Scenario through the GUI 
 
The scenario is already loaded into StateCU and the program returns to the StateCU main page.  Under 
“Edit” click on the “Model Control Options” to view analysis options, including CU method and effective 
precipitation methods, as well as scenario descriptions. Under “Analysis Options” you can also opt to use 
Soil Moisture by checking the box.  This will activate the “Soil Moisture Options” button.   
 



      16 
 

 
 
By clicking the “Soil Moisture Options” the following window will open.  Here you can set the initial soil 
moisture capacity if known or use the Presimulation option.  Winter carryover percentages can be set here 
as well. 
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Back under “Model Control Options”, under the “More Options” tab, you can choose your type of output 
and review your filling options.  Remember to save your revisions under the “File” menu and clicking on 
“Save”. 
 

 
 
Close out of the “Model Control Options” window, return to the StateCU main page and click on “Edit” 
menu and then click on “Structure Information”. 
 
In this window, you can view and edit climate station assignments, diversion data, crop acreages, 
efficiencies, latitude/elevation, and AWC of the structure. The AWC soil capacity values (in/in) can be 
found on the http://websoilsurvey.nrcs.usda.gov/app/  website for your specific site. 
 

http://websoilsurvey.nrcs.usda.gov/app/�
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Click on the “Efficiency Information” to change the conveyance and irrigation efficiencies.   You can 
click on one and make the change, then copy the value down. Remember to save changes to both the 
efficiency window and the structure information window by clicking on “File” and then “Save”. 
 



      19 
 

 
 
Click on “Historical Surface Water Diversions” to adjust the historical diversions of the structure.  This 
window will allow you to copy all the data to an Excel spreadsheet where you can manipulate the data, 
then paste the data back into this window. 
 

 
 
Should you have a ditch that is divided up into shares, it is easy to scale down the diversions to match the 
shares.  Highlight the diversion records, right click for scaling/adding options, then enter a fraction to 
scale the diversions by. Remember to save changes to both the diversion window and the structure 
information window by clicking on “File” and then “Save”. 
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Once all your parameters are adjusted, select “Run”, then “Run Simulation”.  Click on “Results” for 
output options.  The detailed water budget output file (dwb), shown below, provides a lot of detail on the 
structure, including potential CU, IWR, non-consumed water and total CU. 
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Also available through the “Results” menu, the “Time Series Data Report Generator” allows the user to 
create custom output files.   
 

 
 
Congratulations!  You have completed a Structure Scenario. 
 
Not covered in this manual is the ability to incorporate groundwater.  Additionally, there is the ability to 
determine a water supply limited crop consumptive use by structure and priority.  StateDMI is needed to 
create some of the files for this determination. 
 
See the StateCU, TSTool and StateDMI User’s Manuals for more information on simulation options and 
additional input files.  
 
HCF/word/StateCU quick start 


